
CADD Production Criteria Handbook (CPCH)
FDOT2008 XM Revision
Record of Changes

Chapter Section Description
NOTE: CPCH chapter headers updated to reflect new Effective date and Release 

description.  All hyperlinks updated to current locations.  Updated all images and 
FDOT2004 references to FDOT2008 versioning.  All references to the "SiteMenu" 
have been changed to reflect "FDOT Menu".

1 Chapter 1 Introduction
1.3 3rd paragraph - Updated to current FDOT2008 versioning information.
1.5 Added contact information for submitting revisions and update comments and updated 

form.

2 Chapter 2 FDOT CADD Software
2.2 Added information regarding the use of the Enterprise application known as the 

Software Distribution Notification Application (SDNA)
2.4 Added "Additional products used may also be found in the CADD Customer Support 

Guide mentioned in section 2.3 previously."
2.5 Updated current FDOT2008 version information and replaced listing of versions with 

reference.
2.6 Added qualifying verbiage.

3 Chapter 3 MicroStation Resource & Support Files
3.1 Changed Cell Libraries. Updated to current FDOT2008 versioning, FDOT Menu 

verbiage and listing of cell libraries.verbiage and listing of cell libraries.
3.2 Changed to FONTS and updated to current FDOT2008 versioning.
3.2.1 Changed to Zdotfont.rsc
3.3 Changed to Text Size and Spacing
3.3.1 Changed to Standard Text Sizes
3.3.2 Removed
3.4 Changed to new section named DATA and added new verbiage.
3.5 Updated current FDOT2008 versioning information.
3.6 Changed to Seed Files
3.6.1 Assigned new subsection to English 2D Seed File
3.6.2 Assigned new subsection to English 3D Seed File
3.7 Changed to new section named Symbology and added new verbiage. 
3.7.1 Added new subsection named DGNLibs with new verbiage and table.
3.7.2 Assigned new subsection for Color Tables under Symbology and updated color table.

3.7.3 Assigned new subsection for Line Styles under Symbology.
3.7.3.1 Assigned new sub-subsection for Standard English Line Style Measurements for 

Plotting and updated style measurements.
3.7.3.2 Assigned new sub-subsection for FDOT Custom Line Style Resource Files.
3.7.3.3 Assigned new sub-subsection for Custom Line Style Graphics.
3.7.4 Assigned new subsection for Line Weight under Symbology
3.8 Changed to new section named Database and added new verbiage defining the 

GEOPAK Design & Computation Manager.
3.9 Added new section named Control Files with new verbiage.
3.10 Added new section named Rule Files with verbiage consolidated from the Discipline 

chapters.  This section to include subsections to define FDOT Standard File Naming 
Convention, FDOT Standard File Names, Descriptions and Rule files, and rule file 
tables reflecting associated FDOT Standard Level names and attributes.

3.10.1 Added new subsection named FDOT Standard Graphic File Naming Convention with 
new verbiage.



3.10.2 Added new subsection named FDOT Standard File Names, Descriptions and Rule 
Files with new table reflecting Critical Files, Discipline, Filename, File Description and 
associated Rule File.

3.10.3 Added new subsection named FDOT Standard Rule File Names & Descriptions 
reflected in a table.

3.10.4 Added new subsection named FDOT Standard Levels by Rule File with a new sub-
subsections containing on table per Rule File with associated Levels.

3.10.4.1 
thru 
3.10.4.35

Added new sub-subsections named for each FDOT Rule File.  Symbology Tables were 
moved from the each discipline chapters and restructured in one listing of Tables per 
Rule File with associated Levels, reflecting Critical Level, Rule File Name, New Level 
Number, Level Name, Level Description, ByLevel Color, ByLevel Style, ByLevel Weight 
and in some also included are Point/Line and Feature codes.

4 Chapter 4 Project Directory Structure
4.1 Updated with current FDOT2008 versioning information.
4.1.2 Removed the last sentence:  " Some functionality was added to the PEDDS utility to 

assist with this task."
4.1.3 Added clarifying verbiage regarding copying.
4.1.4 Added clarifying verbiage regarding usage of full or relative path. Updated the change 

from using Sitemenu to FDOT Menu and the change of the FDOT Menu option Utils to 
Actions.

4.2.1 Updated the Standard File Name Extensions table.
4.2.2 Added verbiage: (a padded integer, i.e. “00”, “01”, “02” … “99”) to ## = 
4.2.3 Updated the current FDOT2008 versioning information.  Added Sheet Numbers 

information in the first two paragraphs.  Added the section on:  "The following shows 
how Sheet Navigator and EDI will interpret sheet numbers to attempt to discern what 
plans component the sheet belongs to:" with table of Prefixes and Components.  Under plans component the sheet belongs to:  with table of Prefixes and Components.  Under 
Output File Naming Convention, added "NOTE: on old projects - now obsolete, but 
included here for reference." and moved "NOTE:  EDI Maintenance Release 3 and 
Subsequent version....." to be placed at the end of section on Source Design File 
Name.  Under Plans Component Code, changed 0010 - Right of Way Maps and 0011 
to 0099 - Unknown.  Under Current Postscript File Naming Format, added "NOTE:  
Used for contemporary projects." and removed: "NOTE:  Used for contemporary 
projects."  Added "All new projects subsequent to November 2006 should use the new 
output format." to the final paragraph.

5 Chapter 5 Project Indexing & Journaling
5.1 Index.XML verbiage change:  "This file is only required for those projects prepared with 

the FDOT2004 software  and beyond, as it can only be produced with the Electronic 
Delivery Indexer Version 2. This file is placed in the root directory of the project."   
ProjectIndex.XML verbiage change:  "From this index, an HTML report can be 
produced (Sheetndx.htm) by the ProjectBrowser EDI application ..."  Removed all 
reference to Project Browser.  Added to forth paragraph: "Since the files mentioned 
above are text based, a user could conceivably produce these by other means, albeit 
with difficulty."  Removed EDI versioning.

5.1.1 Removed Indexing Postcript Images section
5.2 Removed EDI versioning.

6 Chapter 6 Plotting & Postscript Image Files
6.1 Added clarifying verbiage and removed: "Refer to the Electronic Delivery software’s 

documentation for details regarding the configuration and use of these utilities." from 
the first paragraph.  Removed last reference:  "Refer to the CPCH Chapter 3, Section 
3.5, Plot Driver Descriptions, for additional information."

6.2 Updated the Plot Border table.
6.3 Removed verbiage in reference to the Department's "...migration from paper plans..." in 

the first paragraph.  Added some clarifying verbiage in subsequent paragraphs.



6.5 Removed verbiage:  "Refer to the CPCH Chapter 3, Section 3.5, Plot Driver 
Descriptions, for additional information."

6.5.1 Added to first paragraph first sentence:  " ... supplied by FDOT."  Removed last half last 
sentence second paragraph: "...basis and shall meet the requirement specified under 
the Quality and Reproduction."

7 Chapter 7 CADD Quality Assurance / Quality Control
7.1 Qualified acronyms for plain language directive.  Added qualifying verbiage for 

"minimum" threshold of compliancy and "later project phases".
7.2 Qualified acronyms for plain language directive.  Added qualifying verbiage for "the 

rules of the Florida Boards of Professional Regulation and implemented in the 
Professional’s Electronic Data Delivery System (PEDDS) software".

7.4.1 Updated CADD design/delivery components listing.
7.4.2 Added the verbiage: "...of both the districts and ECSO."
7.5 Added qualifying verbiage for more concise descriptions of the FDOT QC software.

7.5.1 Added qualifying verbiage in first paragraph.  Updated "item checked by FileChecker".  
Removed: "A Video tutorial for the operation of the FileChecker utility is available on 
the Florida Department of Transportation, Engineering / CADD Office website here."  
Enhanced "IMPORTANT NOTE" with stronger verbiage. FileChecker Reports:  

Added:  "FileChecker also has a powerful search tool that can search for text strings, 
including multiple occurrences, within files." "NOTE:  The report screens have 
additional controls to sort data in columns (by clicking in the column header) and some 
have pull-down lists to access additional data."
Removed:  "A Video tutorial for the operation of the FileChecker utility is available on 
the Florida Department of Transportation, Engineering / CADD Office website here." 
"FileChecker also has a powerful search tool that can search for text strings, including FileChecker also has a powerful search tool that can search for text strings, including 
multiple occurrences, within files."

7.5.2 Removed all verbiage reflecting "How to" instructions.  This will be included in a new 
FDOT QC Software training document found on the ECSO training website.  Added 
qualifying verbiage for more concise descriptions of the FDOT QC software.

Added:  NOTE:  For detailed listing of the current FDOT Standard Files and 
corresponding FDOT Standard Rule File information, see Chapter 3.10 of this 
document.

NOTE:  For a more in-depth instructional document on the FDOT QC Software, go to 
the ECSO Website:

http://www.dot.state.fl.us/ecso/main/fdotcaddtraining.shtm

Removed:  "QC Toolboxes, QC-Std and Cleanup and QC Utilities sections
(7.5.2.1 thru 
7.5.2.5)

Removed all verbiage reflecting "How to" instructions.  This will be included in a new 
FDOT QC Software training document found on the ECSO training website.  Added 
qualifying verbiage for more concise descriptions of the FDOT QC software.

7.5.3 Removed all verbiage reflecting "How to" instructions.  This will be included in a new 
FDOT QC Software training document found on the ECSO training website.  Added 
qualifying verbiage for more concise descriptions of the FDOT QC software.

8 Chapter 8 Electronic Delivery Procedure
8.2 Removed Project Browser



8.4.3 Removed "Using Multi line to Validate ASCII Text Files"  step by step instructions.  
Added:  "Note:  For a step by step demonstration of importing an ASCII text file in Multi-
Line Earthwork, go to the ECSO Training website:

http://www.dot.state.fl.us/ecso/main/fdotcaddtraining.shtm"

8.6 #11 Added: " Project Delta will no longer output a DeltaNDX.htm file, it will append the 
revision number selected to the end of the file in the format of DeltaNDX#.htm."

#12 Replaced with: " 12. Update the Sheet Index Report (SheetNDX#.htm) and project 
composite PDF (Project#.PDF) using EDI.

Note: These actions in Step 12 are necessary for defining the state of the project as will 
be reflected in the Revised Project CD deliverable. The new SheetNDX#.HTM file and 
Project#.PDF file will make reference to all sheets currently active in the project 
following the revision. However, as required in Step Number 10, the updated project 
sheets are assembled into a composite revision PDF as needed for the Plans and 
Specs Revision CD deliverable used in the letting process."

#13, 14 & 15 Added: "13. Create the composite Project#.pdf with EDI.  This file 
contains all sheets currently part of the project.  Select the appropriate index as defined 
by DeltaNDX#.htm for each revision.
 
14. Create the Sheetndx#.htm, which is the index for all sheets in the project.  Select 
the appropriate index as defined by DeltaNDX#.htm for each revision

15. Additionally create the composite Revision#.pdf by selecting the appropriate 
DeltaNDX#.htm, from the project root folder.  EDI will automatically prompt for and then DeltaNDX#.htm, from the project root folder.  EDI will automatically prompt for and then 
reads the data from DeltaNDX#.htm to create Revision#.pdf.  Only revised sheets are 
included in the revision PDF, as found in the DeltaNDX#.htm index.

Note: This action is necessary to produce a PDF file of the revised sheets to be 
included in the Plans and Specs Revision CD deliverable.  An example of a 
Revision1.PDF is shown below:
#17 Added Note: "Note:  In SetMaker, if the Source Directory folder contains more than 
one deltandx.htm file, the user will be given the option to select which deltandx file will 
be the active one.  See image below."

8.7 #8 Added: "8. Press the [Create] button. StrungProject will ask for some identification 
information to create a Project Identification file (ProjectID.xml) in the \_meta_info 
folder of the root strung project structure.  This Project ID file is copied from the Lead 
project, and modified slightly by Strung Project so that PEDDS will recognize the strung 
project as a unique project (a new PEDDS Project key is created). Likewise, a “seed” 
Manifest file (Manifest.xml) is also created in the \_meta_info folder; however it does 
not contain any file listing data (URLs or Hash codes)."

#9 Replaced: "9. On the User Info dialog, Press the [Cancel] button to return to the 
main StrungProject Screen, 
 (OR) press the [Continue] button and . StrungProject will begin creating and 
completing the appropriate strung project directory structure, and then start copying e.  
Each of the component ‘Lead’ and ‘Goes-with’ sub-projects will be copied into the 
strung project structure. As copying takes place, Strung project displays a progress 
bar, and descriptive text about what is being processed.  
 
 Note:  As described previously StrungProject will also create the ProjectID.xml and 
Manifest.xml files at this point."



#9 Replaced: (conti) "Note: The strung project directory structure is not secured by 
StrungProject – use PEDDS to do all securing.

Once StrungProject has created the directory structure and all appropriate files the 
strung project's Manifest data is complete, StrungProject will append any "Project.PDF" 
files found in the Lead and Goes-with project(s) and place the appended composite 
(also called Project.PDF) in the root directory of the strung project.  
GhostScript runs , with no user interface, once for each Project.PDF found in the 
component projects(s), and builds the composite Project.PDF in the root directory of 
the strung project. StrungProject displays a progress bar and descriptive text as all the 
PDFs are being un-distilled to PostScript, concatenated, and re-distilled back to PDF, 
which is a very computer intensive operation, so be patient please."

9 Chapter 9 Right of Way Mapping CADD Standards
9.1.7 Added to the Cell Table:  Property Line Hook element, C=PLHOOK Type
9.1.8 Standard Symbology Table updated to reflect changes resulting from the QC Review 

Committees.
9.2 Removed Geopak from the title
9.2.3 R/W Hot Boxes:  Removed:  "The browser must have been previously opened before 

the HotBox icon will open the browser." "The HotBoxes can be positioned anywhere in 
the design file by moving your cursor to the center of the HotBox (so it displays as a 
pointer) and dragging to the desired location. The user must then right click anywhere 
on the SiteMenu bar and save these settings through SiteMenu > Save Settings."  
Added new Hot Boxes:  Run Plot Scale; Run Quikchek

9.2.5 • Create Cover Sheet > With Map(DGN):  Removed:  Section for "Units: 9.2.5  Create Cover Sheet  With Map(DGN):  Removed:  Section for Units: 
Metric/English"; "Place Clipped Area in Master File > This option places the clipped 
area of the County Map File into the same design file the Cover Sheet is to be drawn 
into."; "Place Clipped Area in Reference File > This option places the clipped area of 
the County Map File into a reference design file.  When this option is active the dialog 
will include an input line for location of the reference file and its name:"  Section for 
"Clip Key Map > " removed "or in the master file depending on the user's section"

9.2.6 Scale All Custom Line Styles - Verbiage changed from "The desired custom line style 
scale is entered in the text window." to "Select the desired custom line style scale and 
then click the Scale Lines button...."

9.2.8 Added new Cell section for "North Arrow - This command automates the process of 
placing a north arrow. The English cell library row.cel must be attached to the current 
design file. The program will prompt the user if it cannot find the required cell library."

9.2.9 Place Delineators - Added with image:  "Select Your Plot Scale – Sets the required 
scale for R/W Mapping standards for placement of the delineator arrows. Multiple 
scales are place in the pull down."  Added to "Leader Above Line" and "Leader Below 
Line" – "depending on the direction the line was original drawn in."

9.2.11 Added in 5th paragraph:  "GEOPAK Legal Description Editor must be running for this ap
9.2.12 Removed "Drafting Tools" section
9.2.13 Removed "Spot Check, Spot Fix, View DGN Difference, Manage Reference Files, 

QA_Input and Gridscan" from the R/W Menu and QC Toolbox.  These GDM QC 
applications have been retired.

9.3 Plans Preparations Toolbox has been updated.
9.4 Removed "Geopak" from the "Plan Sheet Layout" description.
9.4.1 Replaced "Geopak" with "Civil Extension" and added new menu option for accessing 

"Plan/Profile Sheet Computation".
9.5 Removed "Geopak" from the "Design and Computation Manager" title.



9.5.1 Removed "Geopak" from the "Selection of R/W Database (English)" title. Added:  "The 
file can be accessed through the MicroStation main menu by selecting:
Applications>MicroStation Civil Extensions> Design & Computation Manager
Or...."  Removed:  "The file can be accessed..."

9.7 Removed:  "o FDOT2004 – uses the V8 file format and FDOT2004 CADD standards. 
This option requires existing files to be converted for both file format and CADD 
Standards. All new supporting files and programs are accessible." 
Updated all the prior versioning images.

9.8 Removed:  "There are three basic options available to consider prior to converting 
active design files:

1. No Conversion – When a projects/design files are near completion such as 90% or 
greater and require negligible use of Geopak, the FDOT2002_V7 workspace should be 
used.
2. Convert File Format Only – Those projects/design files that are between 60% and 
90% and require additional work using design software the FDOT2002_V8 workspace 
with existing support files should be used.
3. Convert File Format and Migrate to new FDOT2004 Standards – All projects/files 
that are 60% or less that require extensive use of Geopak should be converted to 
MicroStation V8 file format and continue development with the FDOT2004 workspace.

Additional considerations:"

10 Chapter 10 Environmental Management Standards
10.2 Changed Standard File Name from UTCPEM.dgn to PLPREM.dgn10.2 Changed Standard File Name from UTCPEM.dgn to PLPREM.dgn
10.5 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

11 Chapter 11 Survey Standards
11.2 Added new non-critical Standard File Name: TREERD.dgn with File Type - Existing 

Topography;  Model Name - Default File Description - Tree Survey Sheet; Rule File -  
topord.rul; Seed File - $(MX_SEEDIR)fdotseed2d.dgn. 

11.3 Removed from 2nd paragraph:  " The “V8” refers to the new standards for level names 
implemented for MicroStation V8."

11.5 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 
Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

12 Chapter 12 Drainage Standards
12.4 Removed the verbiage "Hydrology".
12.6.1 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

12.7 Replaced verbiage for Drainage Map: (not usually in a plan set, but kept on the server 
The Drainage Map may be considered as optional to be included in the Final Plans 
submittal at the discretion of the individual Districts)

13 Chapter 13 Roadway Standards
13.2 Changed Standard File Names from:  PLAN_MOTIF.dgn to MTPLRD.dgn; 

PROFILE_MOTIF.dgn to MTPRRD.dgn.  
Added new Standard File Names: AMGMRD.dgn, File type - Cross Sections, Model 
Name - Default, File Description - Automated Machine Guidance Model (3D), Seed file -
$(MX_SEEDIR)fdotseed3d.dgn



Added new Standard File Names: GKLNRD.dgn, File type - Cross Sections, Model 
Name - Default, File Description - Geopak Lines for Existing Features, Seed file - 
$(MX_SEEDIR)fdotseed2d.dgn
Removed Standard File Name:  URCPRD.dgn - This was replaced with PLPRRD.dgn 
which already exists.
Added to Note:  "Refer to Chapter 19 for the Utility symbology standards."

13.7 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 
Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

14 Chapter 14 Signing & Pavement Marking Standards
14.5 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

15 Chapter 15 Signals Standards
15.5 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

16 Chapter 16 Highway Lighting Standards
16.5 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

17 Chapter 17 Landscape Standards

17.5 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 17.5 Moved Level Symbology table to CPCH Ch 03.10 where these tables are set up by 
Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

18 Chapter 18 Structures Standards
18.2 5th paragraph added verbiage regarding Geotech files: "...are listed to show the order 

of placement within the Structures plans component only. All Geotech files should be 
located in the Geotech discipline folder and..."
Added new filename: B#SlopeProtectionConcrete.dgn  and renumbered Sheet Order 
within the Structures Plans Naming Convention and Numbering Convention table.

18.6 Removed Common and Survey Library entries from the symbology table.
18.6.1 1st paragraph replaced verbiage: "sheets that reside in other component areas of the 

plan set shall use the corresponding component area’s border cell" with "Sheets 
requiring Structures design that reside within other discipline components of the plan 
set (Roadway, Lighting, etc.) shall use the Border Roadway w/Initials cell “Sheet-
Rdwy”."
"Scales" tables Height and Width updated.
"Text Sizes and Weights" table updated

18.9 2nd paragraph removed verbiage: "The Quality Control Process does not analyze 
reference files."
3rd paragraph removed: "Structures design files for projects let before July 1, 2003 
containing non-Structures elements are exempt from the Quality Control process and 
should be noted as an exception in the Quality Control Report."

19 Chapter 19 Utilities Standards
19.3 1st paragraph removed the verbiage:  "The first and preferred option is the exchange 

of graphic files (DGN or DWG) and the second is the creation of ASCII input files.  The 
procedures for both are defined below."

19.5.3 Renamed file names:  PLAN MOTIF to MTPLUW; PROFILE MOTIF to MTPRUW; 



Added file name: UTVHUW for UWHC Summary of Survey Verified Utilities (3D).
19.8 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

19.9.3 - 
19.9.5

(AUTOCAD Environment; Utility File Locations; and Syntax) Removed all verbiage in 
reference to AutoCAD.  New configuration information is under development for FDOT 
to implement acceptance of AutoCAD format in design files set for 2010.

19.10.6, 
19.11

HotLists and Hot Boxes are removed.

19.16.2 - 
19.16.3 

(Basic Translation Issues and DWG Import/Export Settings for Standardization of Files) 
Removed all verbiage in reference to AutoCAD.  New configuration information is 
under development for FDOT to implement acceptance of AutoCAD format in design 
files set for 2010.

20 Chapter 20 Geotechnical Standards
20.6 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

21 Chapter 21 Construction Standards
21.5 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

21.7 "Steps for Construction's use of Electronic Data" updated to current versioning.

22 Chapter 22 Intelligent Transportations Systems (ITS) Standards
22.2 Renamed file names:  PLAN_MOTIF to MTPLIT; PROFILE_MOTIF to MTPRIT
22.6 Moved Level-Symbology table to CPCH Ch 03.10 where these tables are set up by 22.6 Moved Level Symbology table to CPCH Ch 03.10 where these tables are set up by 

Rule File. Added verbiage to clarify Symbology Standards and Level naming 
convention rules.

23 Chapter 23 Architectural Standards
Formatting and plain language corrections made only.

24 Chapter 24 Specification Standards
Formatting and plain language corrections made only.

25 Chapter 25 Appendix
Grammatical errors corrected only.
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